# Table of Contents

- Table of Contents ........................................................................................................... 1
- Audio interface and control surface ............................................................................... 3

## Install and setup Cubase LE 4
- Installation overview ..................................................................................................... 5
- R16 audio interface system environment ..................................................................... 6
- Connecting and disconnecting in audio interface mode ........................................... 7

## Control surface functions
- Using the control surface functions ........................................................................... 9
- Fader section operation ............................................................................................... 11
- Setting up function keys ............................................................................................. 13

## Control Surface Functions Quick Reference Sheet .................................................. 14

## Recording with Cubase LE 4
- Create a new project .................................................................................................... 15
- Create a new audio track ............................................................................................. 16
- Connect an instrument .................................................................................................. 17
- Set the recording level .................................................................................................. 18
- Recording ...................................................................................................................... 19
- Checking the recording (playback) .............................................................................. 19

## Importing audio data into Cubase LE 4
- Importing by drag & drop .......................................................................................... 21
- Using the “Import” command ...................................................................................... 23

## The mixer in audio interface mode
- Volume, reverb send and pan ....................................................................................... 25
- Stereo Link .................................................................................................................... 25
- DIRECT/DAW BALANCE ............................................................................................. 25
- Tuner ............................................................................................................................. 26
Effects in audio interface mode
- Insert effect .............................................. 27
- Send return effect (reverb) ................................ 27

Working with patches
- Patch operations ............................................. 28
- Patch initialization (factory reset) ......................... 28

Control surface setup for other DAWs
- Logic 7/8 .................................................. 29
- SONAR 7/8 .................................................. 30
- LIVE 6/7 .................................................... 31
- Digital Performer 5/6 ........................................ 32
Audio interface and control surface

This section explains how to set up and use the functions of the R16 audio interface and control surface with DAW software installed on your computer.

Functions of the audio interface and control surface

Audio interface
The various input and output jacks of the R16 can be used as a Hi-Speed USB (USB 2.0) audio interface with support for 8 ins and 2 outs and input and output quality up to 24-bit/96kHz. Effects can also be used when the sampling rate is 44.1 kHz, and the unit can be powered by the computer’s USB bus.

Control surface functions
The on-board control surface functions can be used to control DAW software on your computer via USB. Transport operations, including playback, recording and stopping, and physical control of the DAW faders are possible. Furthermore, various other DAW software functions can be mapped to the F1–F5 keys. (The available functions depend on the DAW software used.)
Supports input from a variety of sources, including guitars, mics and line level instruments.

The 8 onboard jacks, which accept XLR and standard phone plugs, include one high-impedance input and two with 48V phantom power. From high-impedance guitars and basses to dynamic and condenser microphones and line-level devices like synthesizers, many sources are supported. In addition, the built-in high-performance condenser microphones are convenient for recording acoustic guitar and vocals.

Versatile effect functions

The insert effect can be applied to specific channel paths and the send/return effect works via the mixer send/return. The two kinds of built-in effects can be applied when recording, of course, but they can also be applied to affect only the monitoring output. For example, when recording vocals, you can apply reverb to the monitor signal to make singing easier, but record a dry signal.

Comprehensive built-in mixer

Using the R16’s mixer, you can make a mix for monitoring live and playback. When simultaneously recording guitar and vocals, for example, you can independently adjust volume balance, panning and reverb levels.

Multifunction tuner

In addition to standard chromatic tuning, the multifunction tuner also has on-board support for 7-string guitar, 5-string bass and various drop tunings.
Cubase LE 4 installation overview

To use the R16 with a DAW, you need to install an R16 driver and set the DAW so that it can recognize the R16. Here, we explain how to do this with Cubase LE 4.

1 Audio interface

By using the R16 between a computer and external devices and instruments, their signals can be recorded using programs such as DAW software. Instrument types that require Hi-Z or phantom power can also be connected.

2 Control surface

Using the fader or keys on the R16, you can control transport operation and mixing in digital audio workstation (DAW) software on your computer.

---

**Install DAW software** ... P.5

- Cubase LE 4

**Install driver**

- ZOOM R16 audio driver

**Connect R16 to computer** ... P.7

- Audio interface setup

**DAW software setup** ... P.9, 29

- Device setup
  - ZOOM R16 audio driver

- Control surface setup
  - Mackie Control

**Recording** ... P.15
R16 audio interface system environment

To use DAW software with this unit, you need to install it and make settings in it for the R16. This is an explanation for doing so with Cubase LE4.

**R16 audio interface system requirements**

**Windows**
Windows® XP SP2 or later/Windows® Vista SP1 or later
1.8GHz Intel® Pentium® 4 or faster
1GB RAM minimum

**Intel Mac**
OS X 10.4.11 or later/10.5 or later
1.83GHz Intel® Core™ Duo processor or faster
1GB RAM minimum

**Both**
USB 2.0 compatible port

* 64-bit operating systems are not supported.
* USB hubs are not supported.

**About the screen images**
The screen images are of the Windows version.

**About trademarks**
- The SD symbol and SDHC symbol are trademarks.
- Windows®/Windows Vista® are trademarks or registered trademarks of Microsoft®.
- Macintosh®, Mac OS® and Logic are trademarks or registered trademarks of Apple Inc.
- Steinberg and Cubase are trademarks or registered trademarks of Steinberg Media Technologies GmbH Inc.
- Intel® and Pentium® are trademarks or registered trademarks of Intel Corporation.
- AMD Athlon® is a trademark or registered trademark of Advanced Micro Devices, Inc.
- MACKIE Control is a trademark or registered trademark of LOUD Technologies.
- SONAR is a trademark or registered trademark of Cakewalk, Inc.
- Ableton Live is a trademark or registered trademark of Ableton AG.
- Digital Performer is a trademark or registered trademark of Mark of the Unicorn.
- All other trademarks, product names, and company names mentioned in this documentation are the property of their respective owners.
- All trademarks and registered trademarks mentioned in this manual are for identification purposes only and are not intended to infringe on the copyrighted properties of their respective owners.
Connecting and disconnecting in audio interface mode

This is a brief overview of connecting and disconnecting when a computer is hooked to the R16 by USB cable. For details, please refer to the separately attached “Installation Guide.”

### Connecting the R16 to the computer for the first time

1. Install Cubase LE 4 DAW software on the computer
2. Download the latest ZOOM R16 audio driver from the ZOOM website (see below).
3. Install the audio driver on the computer.

**Install/setup details**

Reference: “USB/Cubase LE 4 Install Guide”

4. Connect the R16 to the computer.

5. Setup DAW software
   - Device setup P.00
   - Control surface setup (Mackie Control) P.00

### R16 setup and connection

Follow these procedures from the second time connecting

1. **USB** Press [USB].
2. Select >AUDIO INTERFACE. Press [Enter].
3. Verify. Press [Enter].
4. Select “Continue.” Press [Enter].

### NOTE

The ZOOM R16 audio driver is essential for using the R16 as an audio interface for DAW software such as Cubase LE 4. When downloading, follow the included instruction guide to install correctly.

- Please download the latest R16 audio driver from Zoom Corporation’s website at (http://www.zoom.co.jp).

### NOTE

- Set the recording quantization (bit depth) of Cubase LE 4 or the DAW software that you are using to 24-bit in order to achieve the best audio quality when recording. (See the software manual for how to make this setting.)
5 Connect the USB cable to the R16.

The [DEVICE] USB indicator will light.

6 Connect the USB cable to the computer.

When connection is complete the AUDIO INTERFACE icon appears.

---

**NOTE**

Data transferred with CONTINUE
- INSERT EFFECT settings
- SEND RETURN EFFECT settings
- Track parameter settings
- TUNER settings

RESET
Restores default settings for each item

- The audio interface and control surface functions of the R16 can be used by drawing power through the USB bus. Power from batteries or the adapter is not necessary.
- We recommend always using the latest R16 system software. Operating the R16 with an older system could result in it not being recognized by your computer.
Using the control surface functions

When using the R16 connected by USB as an audio interface, the R16 keys and faders can be used to control Cubase LE 4’s transport and mixer.

**About the control surface**

In control surface mode the keys and knobs on the R16 can be assigned to particular Cubase 4 LE functions.

**Control surface settings**

See R16 setup and connection steps 1~6 on P.7~8.


8. Select “Device Setup” from the Cubase LE 4 “Device” menu.

9. On the top left of the device setup window there are [+][-][<] buttons. Click the [+] and then choose “Mackie Control.”

**HINT**

Assigning Keys

For a list of functions that can be assigned to the knobs and keys of the R16, as well as other transport/function keys that are supported by Cubase LE 4, please consult the “Control Surface Mode Functions Quick Reference Guide” of this manual.

Set MIDI input and output.

MIDI Input: Zoom R16
MIDI Output: Zoom R16
Transport section

By setting up the control surface, the R16’s transport section keys can be assigned to individual functions in Cubase LE 4.
Fader section operation

By using the faders and status keys of the R16 fader section, you can control the volume and muting, pause recording and switch solo on and off in the corresponding Cubase LE 4 tracks.

### About banks

After setting up control surface operation, the main parameters of Cubase LE 4 can be operated using the R16’s fader and status keys.

A group of tracks operated by the faders and status keys is called a "bank," and one bank includes 8 tracks.

For example, if fader 1 is assigned to Cubase LE 4 track 1, tracks 1-8 can be operated as shown in the following diagram.

<table>
<thead>
<tr>
<th>Control</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
</tr>
</thead>
<tbody>
<tr>
<td>Track</td>
<td>Tr.1</td>
<td>Tr.2</td>
<td>Tr.3</td>
<td>Tr.4</td>
<td>Tr.5</td>
<td>Tr.6</td>
<td>Tr.7</td>
<td>Tr.8</td>
</tr>
</tbody>
</table>

As the diagram shows, pressing the [9~16tr (Bank>)] key once switches the allocations as shown below.

<table>
<thead>
<tr>
<th>Control</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
</tr>
</thead>
<tbody>
<tr>
<td>Track</td>
<td>Tr.9</td>
<td>Tr.10</td>
<td>Tr.11</td>
<td>Tr.12</td>
<td>Tr.13</td>
<td>Tr.14</td>
<td>Tr.15</td>
<td>Tr.16</td>
</tr>
</tbody>
</table>

- **1-8Tr**

- **[1-8Tr] Key (< BANK)**
  Tracks (channels) assigned to the fader section are moved backward by eight tracks.

- **9-16Tr**

- **[9-16Tr] Key (BANK >)**
  Tracks (channels) assigned to the fader section are moved forward by eight tracks.

### Operating the fader section

1. **Assign the desired Cubase 4 LE tracks (channels) to the fader section.**

2. **Use the faders to control the volumes of the corresponding tracks.**

The faders control the volumes of their respective tracks. Change the master volume by moving the [Master] Fader.
3 Press the MASTER track status key to cycle through the functions of the individual track status keys.

By pressing a track status key, you can toggle solo, mute and record enable on and off for the corresponding track.

R16 level meters
(audio interface use)

Each level meter other than the MASTER displays the signal immediately before sending it to the computer.

The mastering level meter displays the returning signal from the computer.

Checking DAW recording levels

By setting “REC SIGNAL” to “WET” (signal with effect) or “DRY” (no effect), you can send signals to the computer with or without being processed by the R16’s insert effects.

The recording levels of the sent signals are displayed on the level meters. The signals shown on the mastering level meter and each level meter are different.

Please adjust the level meter so that it does not light the red clip indicator.
Setting up function keys

The five keys above the transport keys can be used as function keys (F1~F5) and assigned as you desire.

Function key setup method

1. **Open the Device Setup Dialog Box in Cubase 4 LE**

2. **Select Mackie Control**
   
   Commands can be assigned in the three columns displayed on the right side of the window.

3. **From the (Button) column choose the function key [F1~F5] to be assigned a Cubase LE 4 function.**

4. **Click on the “Category” column for that key.**

5. **Choose the type of Cubase LE 4 function from the Category pop-up menu.**

6. **Click on the “Command” column and select the desired specific Cubase LE 4 function from the pop-up menu.**
   
   (The contents of this pop-up menu will be different depending on the category chosen.)

7. **Press the “Apply” button.**
## Control Surface Functions Quick Reference Sheet

These functions are for Cubase LE 4, Cubase 4, Logic Pro, SONAR, Ableton Live and Digital Performer.

<table>
<thead>
<tr>
<th>Fader section</th>
<th>Control</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status Key</td>
<td>Toggles mute, record enable or solo on the track on/off.</td>
<td></td>
</tr>
<tr>
<td>[MASTER] Status Key</td>
<td>Switches the function of the status keys</td>
<td></td>
</tr>
<tr>
<td>Fader</td>
<td>Controls the volume of the corresponding track</td>
<td></td>
</tr>
<tr>
<td>[MASTER] Fader</td>
<td>Controls the master volume</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Transport section</th>
<th>Control</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Curser] Keys ➔ ➙</td>
<td>Performs the same functions as the arrow keys on the computer (*1)</td>
<td></td>
</tr>
<tr>
<td>Dial</td>
<td>Moves the cursor position (*2)</td>
<td></td>
</tr>
<tr>
<td>[REW] Key</td>
<td>Rewind</td>
<td></td>
</tr>
<tr>
<td>[FF] Key</td>
<td>Fast forward</td>
<td></td>
</tr>
<tr>
<td>[STOP] Key</td>
<td>Stop</td>
<td></td>
</tr>
<tr>
<td>[PLAY] Key</td>
<td>Play</td>
<td></td>
</tr>
<tr>
<td>[REC] Key</td>
<td>Record</td>
<td></td>
</tr>
<tr>
<td>[AUTO PUNCH I/O] Key</td>
<td>Depends on the [F1] key setting</td>
<td></td>
</tr>
<tr>
<td>[A-B REPEAT] Key</td>
<td>Depends on the [F2] key setting</td>
<td></td>
</tr>
<tr>
<td>MARKER [&lt;&lt;] Key</td>
<td>Depends on the [F3] key setting</td>
<td></td>
</tr>
<tr>
<td>MARKER [&gt;&gt;] Key</td>
<td>Depends on the [F4] key setting</td>
<td></td>
</tr>
<tr>
<td>[MARK] Key</td>
<td>Depends on the [F5] key setting</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Control section</th>
<th>Control</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>[1-8Tr] Key</td>
<td>Moves one bank backward</td>
<td></td>
</tr>
<tr>
<td>[9-16Tr] Key</td>
<td>Moves one bank forward</td>
<td></td>
</tr>
</tbody>
</table>

*1: Digital Performer = Window scroll
*2: Digital Performer = No assigned function
Recording with Cubase LE 4

In this chapter, we explain how to record into Cubase LE 4 using the R16.

Create a new project

Copy the ZOOM R16 project templates to the computer.

From the CubaseLE4_template folder on the CD included with R16, copy the templates to the location where Cubase LE 4 is installed.

Windows
C: \Program Files\Steinberg\Cubase LE 4\templates

Macintosh
/Applications/CubaseLE4.app/Contents/templates/

(To access the Contents folder, ctrl-click the Cubase LE 4 application and choose “Show Package Contents” from the contextual menu.)

Run Cubase LE 4.

Choose “New Project” from the File menu.

Choose a new project template from the New Project Window.

Create a new project

After copying the R16 project templates to the designated folder, the R16 project templates will be displayed when creating a new project. By choosing these templates you will be able to easily create projects with audio track input and output settings arranged for the R16.

Template names and details

- **ZOOM R16 8Mono Recording**
  A project with Cubase LE 4 monaural tracks 1~8 assigned to R16 [Input] 1~8

- **ZOOM R16 4Stereo Recording**
  A project with Cubase LE 4 stereo tracks 1~4 assigned to R16 [Input] 1/2 ~ 7/8.

- **ZOOM R16 4Mono 2Stereo Recording**
  A project with Cubase LE 4 monaural tracks 1~4 assigned to R16 [Input] 1~4 and Cubase LE 4 stereo tracks 5~6 assigned to R16 [Input] 5/6 and 7/8.
4 Set the save location and click the OK button (select button on Mac OS X).

The project file save location window is displayed.

This will create a new project and the Cubase LE 4 project window will appear.

5 Create a new audio track

Set-up the created audio track as follows.

Inspector (area that allows setting of detailed track information)

If the inspector is not shown, click here to show/hide the inspector.

Select the track input/output bus. The names of busses of the R16 connected by USB will be displayed. To choose a different bus click here and choose a different bus from the menu.

To add a new audio track, select “Add Track” from the “Project” menu and then choose “Audio” from the sub-menu that appears.

NOTE

• Set the recording quantization (bit depth) of Cubase LE 4 or the DAW software that you are using to 24-bit in order to achieve the best audio quality when recording. (See the software manual for how to make this setting.)

• The inspector displays information about the track currently selected. If it does not display anything click on a track to see that track’s status.
Recording With Cubase LE 4

Connect an instrument

6

Connect an instrument such as a guitar to an R16 [INPUT] jack and choose an effect patch.

The chosen effect patch will be applied to the signal and recorded on the computer via the [USB] port.

How to choose the R16 input signal

Reference : R16 Operation Manual

Selecting an input signal P.13
Selecting an effect patch P.13

7

Select “Mixer” from the Cubase LE 4 “Device” menu

The channels corresponding to the created tracks and the master channel will be displayed in the mixer window.

8

Enable the track for recording.

HINT

When the Monitor button is lit, the audio track input level in the level meter next to the fader will be displayed. When the light is off, the audio track output level will be displayed.
Set the recording level

9. While playing an instrument, adjust the R16 input level and set the Cubase LE 4 recording level.

The recording level for Cubase 4 LE can be checked by the level meter of the corresponding channel of the recording enabled track. Please set it as high as possible without making the meter peak. When adjusting the level, do not move the Cubase LE 4 fader, but instead adjust the recording level and gain on the R16.

NOTE

- If the Monitor button is on, the R16 input signal and the signal returning to the R16 via the computer will both be output from the R16 at the same time which can create a flanger-like sound. If you want to monitor accurately while adjusting the recording level, turn the [DIRECT/DAW BALANCE] knob toward DIRECT.
- For the above meter, the signal level is displayed after it has been internally processed by Cubase LE 4. Because of this, you might experience a slight delay between the time a string is plucked until the level meter moves; this is not a defect.

10. After adjusting the recording level, click the Monitor button to turn off the light.

For this operation the input level is not displayed, and the signal from the computer to the R16 is muted.

For this operation the [PHONES] and [OUTPUT] ports of the R16 can only be used to monitor the signal sent to the computer.

11. Confirm the Transport Panel display

If the Transport Panel is not displayed, select “Transport Panel” from the “Transport” menu.
Recording with Cubase LE 4

Recording

12 Click the Record button on the Transport Panel

Recording begins.
As you play the instrument, a recorded waveform is drawn in real time in the project window. To stop recording, click the Stop button in the transport panel.

Check the recording (playback)

1 Lower the master channel fader

2 Using the Transport Panel buttons, return to the beginning of the project.

3 Click the Play button on the Transport Panel to begin playback.
When using Cubase LE 4, the application’s actions could become extremely delayed or error messages such as “cannot synchronize with USB audio interface” might be displayed. Should such occurrences become frequent, taking the following measures might improve the situation.

1. **Terminate other running programs.**
   In particular, confirm that there are not a large number of background applications running.

2. **Reduce the use of plug-ins in Cubase LE 4 (effects, sound generator plug-ins)**
   If there are a large number of plug-ins running, the computer might be struggling to keep up. In addition, reducing the number of simultaneous playback tracks might be effective.

3. **Use the R16 AC adapter**
   When devices draw power from the USB bus, on rare occasions computer performance can suffer. Try using the AC adapter.

Please increase the Audio Buffer Size in the Device Setup>VST Audio System menu if the sound breaks up.

Please refer to Installation Guide Step 5 for details.

Moreover, if the application performance is extremely slow and regular computer operation is affected, we recommend disconnecting the computer from the R16 USB port and quitting Cubase LE 4 once before reconnecting the USB port and reopening Cubase LE 4 again.

---

**HINT**

If no sound comes out after clicking the Play button following recording, recheck the USB connection settings (Step 6 above).

In addition, confirm that the [DIRECT/DAW BALANCE] control is at the center.

4. **Raise the master channel fader to a suitable playback level.**
Importing audio data into Cubase LE 4

By connecting a computer and the R16 with a USB cable and setting the R16 to function as a card reader, you can import audio data as WAV files into Cubase LE 4 audio tracks.

1. Connect the computer and the R16 ([DEVICE] port) with a USB cable.
2. Press [USB].
3. Select >CARD READER
   - Push [Enter].
4. Verify.
   - Push [Enter]. Access the R16 from the computer.
6. Open the project into which you want to import audio data.
7. Open the R16 SD card from the computer and open the “Audio” folder of the project from which you want to import audio data.
Select the file or files that you wish to import from the “Audio” folder and drag and drop them into the Cubase LE 4 project window.

When a file is dragged and dropped, a window asking what Cubase LE 4 should do with the file will open.

Select either “Different Tracks” or “One Track” as the import method.

Generally, select “Different Tracks” to automatically create one track for each file. The files will be arranged vertically in the project window. Selecting “One track” will create one track with the audio files arranged horizontally. If you drag audio files on top of existing tracks, they will be placed into those tracks.

In the “Import Options” window click the “Copy Files to Working Directory” check box, and click the OK button.

The audio files are loaded into Cubase LE 4.

**HINT**

- The USB cable can be connected even when the computer or the R16 is on.
- If the R16 is connected when off, it can be run on USB bus power.
- Project data is stored in the SD card root directory in folders named “PROJxxx” (xxx=project number). Audio data is stored as WAV files in the “AUDIO” subfolders of each “PROJxxx” folder.
- Master tracks and stereo tracks are stereo WAV files.
- To copy a WAV file from the computer to an R16 project, copy it to the “AUDIO” subfolder of the desired “PROJxxx” project folder (xxx=project number). Then assign the files to tracks using the functions of the R16.
Importing audio data into Cubase LE 4

Using the “Import” command

1. Connect the computer and the R16 ([DEVICE] port) with a USB cable.

2. Press [USB].

3. Select >CARD READER
   Change menu
   Push [Enter].

4. Verify.
   CARD READER
   Enter?
   Push [Enter].
   Access the R16 from the computer.


6. Open the project into which you want to import audio data.

7. From the Cubase LE 4 “File” menu select “Import” and “Audio File...”

The “Import Audio” window appears.
Select the desired audio file or files from the “AUDIO” folder of the project from which you wish to import. Click “Open.”

In the “Import Options” window click the “Copy File to Working Directory” check box, and click the OK button.

When a file is imported, a window opens asking what Cubase LE 4 should do with the files.

Select either “Different Tracks” or “One Track” as the import method.

Generally, select “Different Tracks” to automatically create one track for each file. The files will be arranged vertically in the project window. Selecting “One track” will create one track with the audio files arranged horizontally. If you drag audio files on top of existing tracks, they will be placed into those tracks.

**HINT**
- The USB cable can be connected even when the computer or the R16 is on.
- If the R16 is connected when off, it can be run on USB bus power.
- Project data is stored in the SD card root directory in folders named “PROJxxx” (xxx=project number). Audio data is stored as WAV files in the “AUDIO” subfolders of each “PROJxxx” folder.
- Master tracks and stereo tracks are stereo WAV files.
- To copy a WAV file from the computer to an R16 project, copy it to the “AUDIO” subfolder of the desired “PROJxxx” project folder (xxx=project number). Then assign the files to tracks using the functions of the R16.
The mixer in audio interface mode

In audio interface mode you can make a mix for monitoring using the R16’s internal mixer. In addition, you can adjust the balance of the internal mixer and the sound from the computer.

**Volume, reverb send and pan**

You can be adjust the REVERB SEND, PAN, VOLUME and STEREO LINK settings as in recorder mode. Operation is the same as in recorder mode. (Reference: OPERATION MANUAL P.37)

**Stereo Link**

Link even and odd numbered INPUTS to handle them as a stereo pair.

**The PAN/EQ Menu**

**Volume**

You can set the volume levels for INPUT 1~8 between 0~127 (increments of 1). 100 is the default.

**Send Reverb**

You can change the reverb send levels for INPUT 1~8 from 0~100 (increments of 1) with 0 as the default (same as in recorder mode).

Reverb only affects the monitored signal.

**PAN (Balance)**

You can change the pan for INPUT 1~8 between L100~R100 (increments of 2) with C (center) as the default (same as in recorder mode).

**Note**

The R16 REVERB SEND, PAN, VOLUME and STEREO LINK settings are all saved when you terminate audio interface mode and can be used again the next time by choosing [CONTINUE] when you relaunch audio interface mode.
Tuner

The R16’s tuner can be used in the same way as in recorder mode. For further details please consult the OPERATION MANUAL.

1. Press [TOOL].

2. Select >TUNER

   TOOL > TUNER

   Push [Enter].

3. Select tuner type.

   CHROMATIC 440Hz

   GUITAR 440Hz

   String6

4. Select the base pitch and tune the instrument.

   CHROMATIC 440Hz

   Displays the note closest to the input signal.

   Displays whether the pitch is higher or lower than the displayed note.

HINT

- The default base pitch is 440 Hz.
- Tuners other than the chromatic tuner can be used.
  (Reference : OPERATION MANUAL P.31)

NOTE

Tuner settings are saved when you terminate audio interface mode and can be used again the next time by choosing [CONTINUE] when you relaunch audio interface mode.
Effects in audio interface mode

The R16’s insert and send return effects can both be used when the sampling wavelength is set to 44.1 kHz. Basic operation is the same but there are a few differences in the menus.

### Insert effect

As in recorder mode, select the insert location and the insert effect algorithm, as well as the effect patches to be applied to the recording signal.

#### Insert effect menu

**Select the insert location**

You can set it for any INPUT from 1~8.

No.00:Standard

>INPUT SOURCE

(Reference: OPERATION MANUAL P.49)

**Apply the effect only to monitoring**

If you set “REC SIGNAL” to “Dry,” the effect will only be applied to the monitoring signal and will not affect signals recorded in DAW software.

No.00:Standard

>REC SIGNAL

(Reference: OPERATION MANUAL P.55)

### Send return effect (reverb)

When in audio interface mode reverb can only be used for monitoring. As in recorder mode, you can use the [SEND RETURN EFFECT] menu to change the patch and the [PAN/EQ] menu to set the send level that adjusts the depth of the reverb signal.

#### Send return effect menu

**REVERB SEND**

By altering the send level of the REVERB you can adjust the depth of the added signal.

SEND REVERB

No.00: TightHal

In audio interface mode the [SEND RETURN EFFECT] key opens the “SEND REVERB” menu, which is different from the recorder mode.

(Reference: Printed Manual P.35-45)

(Reference: Audio Interface Manual P.25)

---

**NOTE**

- Effects can only be used when the sampling rate is 44.1 kHz. At all other times it is turned OFF.
- Insert and send return effect settings are saved when you terminate audio interface mode and can be used again the next time by choosing [CONTINUE] when you relaunch audio interface mode.
Working with patches

After you have made many edits, you might want to restore pre-edited settings by initializing the patch. This will return it to its factory preset condition.

Patch operations
For both insert and send return effects

Select an insert effect or send return effect patch
Press either INSERT EFFECT or SEND RETURN EFFECT and select a patch from an algorithm.
(Reference: OPERATION MANUAL P.48)

Patch editing and renaming (EDIT)
By adjusting the effect module parameters you can set it to create the desired result. You can also change the name.
(Reference: OPERATION MANUAL P.53)

Importing patches (IMPORT)
All algorithms (as well as reverb patches) from the effects of the project selected on the R16 can be imported and saved as a single patch.
(Reference: OPERATION MANUAL P.54)
*In the audio interface mode, one complete set of effect data is saved for the mode. There are no project based settings.

Saving patches (SAVE)
Adjusted patches can be saved.
(Reference: OPERATION MANUAL P. 53)

Initializing patches (INITIAL)
Restores patches to their original factory settings (only available in audio interface mode).

HINT
Even if you have not imported patches the initial settings of patches that were used in the recorder mode can be used.

Patch initialization (factory reset)
EFFECT> select patch> PATCH INITIAL

1

Turn EFFECT On if Off

[ ]

PRESS
Enter

2

Select algorithm/patch.

3

Press [ ▼ ].

No.00:Standard

4

Select PATCH INITIAL.

No.00:REVERB

Send return effect (only reverb) example

5

Press [ENTER].

No.00:Standard

Insert effect example

No.00:Standard

Send return effect (only reverb) example

No.00:REVERB

Press [ENTER].

PATCH Initial?

Press [ENTER].
Control surface setup for other DAWs

You can set and use the R16 as a controller in a variety of DAW software besides Cubase LE 4. Please refer to the manual for the software that you are using.

Logic 7/8

Control surface setup

1. Select “Preferences” > “Control surface” > “Setup” from the “Logic Pro” menu.
   This opens the “Setup” window.

2. Click on the top left “New” and select “Install” from the pull-down menu.

3. Select “Mackie Designs/Mackie Control/Logic Control” from the list in the “Install” window and click the “Add” button.

   "Mackie Control" will be added to the setup window.

4. Select the “Mackie Control” icon. Then, from the top of the list at the left set “Out Port” and “Input” to “ZOOM R16” using their pull-down menus.

Function key setup

1. Select “Preferences” > “Control surface” > “Controller Assignments...” from the “Logic Pro” menu.
   This opens the “Controller Assignments” window.

2. From the “Zone” column select “Control Surface: Mackie Control.”

3. Change the functions as you like. Controls F1~F5 correspond to the F1~F5 keys on the R16.

   The above procedures are for Logic Pro 8.

   The names of the menus might be different in a different version of Logic.

   Please refer to the manual for the version of Logic that you are using for details.
Control surface setup

1. Choose option-controller/surface menu to open the controller/surface dialog.

   If a controller/surface has already been selected, click on the "Delete" button and delete the controller/surface.

2. Click the “Add” button and open the “Controller/Surface Setup” dialog.

3. Choose “ZOOM R16” from the drop-down menu of the “Controller/surface” column.

   Select “ZOOM R16” in the input/output port column.

For Cakewalk SONAR, installation of a control surface plug-in is necessary. Please install it when installing the driver.

Function key setup

1. Choose “Option key bind” to open the “Key bind” dialog.

2. Press “Search for the key” in “Setup.”

3. Select a function that you want to assign an F1-F5 key to and then press that key on the R16.

The above procedures are for Sonar 7.

The names of the menus might be different in a different version of Sonar.

Please refer to the manual for the version of Sonar that you are using for details.

**HINT**

The F1~F5 keys on the R16 are labeled as follows.

- F1: [AUTO PUNCH IN/OUT] key
- F2: [A-B REPEAT] key
- F3: MARKER [<<] key
- F4: MARKER [>>] key
- F5: [MARK/CLEAR] key
Control surface setup for other DAWs

LIVE 6/7

Control surface setup

1. After starting Live 7, select “Preferences” from the “Option” (Windows) or “Live” (Mac) menu.

   The Preferences window will open.

2. Click “MIDI” on the left side of Preferences window.

   The setup window related to MIDI will open.

3. Select “Mackie Control” in the pull-down menu of the Control Surface column.

4. Select “ZOOM R16” from the pull-down menus of the Input and Output column.

5. In the MIDI Ports section below, turn “On” the Remote column button for the “Input: Mackie Control Input (Zoom R16)” item.

Function key setup

1. Press the MIDI button at the top right of the main LIVE window to open MIDI map mode.

2. Interface elements that can be assigned will be highlighted in blue. Click on the parameter that you want to assign an F1–F5 key to control.

3. Press the F1–F5 key of the R16 that you want to use to control the selected parameter in Live.

   The above procedures are for Live 7.

   The names of the menus might be different in a different version of Live.

   Please refer to the manual for the version of Live that you are using for details.

HINT

The F1–F5 keys on the R16 are labeled as follows.

F1: [AUTO PUNCH IN/OUT] key
F2: [A-B REPEAT] key
F3: MARKER [<<] key
F4: MARKER [>>>] key
F5: [MARK/CLEAR] key
Launch the Audio MIDI Setup application. (/Applications/Utilities).

Click the MIDI Devices tab and confirm that “ZOOM R16” is displayed.

Click “Add Device.” A “new external device” will be added.

Double-click the “new external device” to open its “Information” window.

Enter the name “R16” in the “Device Name” field.

Click and drag the downward arrow of the original “ZOOM R16” icon and connect it to the downward arrow of the “R16” icon that you added. Use same method to connect the upward arrows.

Start Digital Performer.

Select “Control Surface Setup” from the “Setup” menu. The Control Surface window will open.

Click the “+” icon in the Control Surface window and select “Mackie Control” from the “Driver” pull-down menu.

Select “Mackie Control” from the “Unit” pull-down menu that will be displayed at bottom.

Select “R16” from the “MIDI” pull-down menu of the Control Surface window and select [R16-1] from the menu list.

Click the “OK” button.

The above procedures are for Digital Performer 5. The names of the menus might be different in a different version of Digital Performer. Please refer to the manual for the version of Digital Performer that you are using for details.

Function key setup

The default functions are allocated in Digital Performer and you cannot change these functions.

F1 [AUTO PUNCH IN/OUT]: Selects YES in dialog boxes
F2 [A-B REPEAT]: Selects NO in dialog boxes
F3 MARKER [<<]: Creates track groups/group function
F4 MARKER [>>]: Releases pause and stop of track group/group function
F5 [MARK/CLEAR]: Releases track group/group function

Refer to sections about Mackie Control dialog boxes and track groups in the Digital Performer manual.

Samplitude

- Mackie Control is a registered trademark of LOUD Technologies Co.
- Other trademarks and registered trademarks in this document belong to their owners.
Cubase LE 4 for Windows Guide

This Cubase LE 4 Startup Guide explains how to install Cubase LE 4 on a computer, make connections and other settings for the R16.

To connect the R16 to a computer running Windows Vista (or Windows XP) and to enable audio input/output, proceed as follows. The installation description uses Windows Vista as an example.

1. **Insert the supplied “Cubase LE 4” DVD-ROM into the DVD drive of the computer.**
   
   When you insert the DVD-ROM, a screen asking what you want to do appears. Select “Open folder to view files”. When the contents of the DVD-ROM are shown, open the Cubase LE 4 folder for Windows folder by double-clicking on it, and then double-click the executable “Setup” ( SETUP. exe) file to start the installation process.

2. **If nothing happens when you insert the DVD-ROM, open the Start menu and select “Computer” (My Computer) in Windows XP). Then double-click the “Cubase LE 4” DVD-ROM icon to display the contents of the DVD-ROM.

**HINT**

If you use Cubase LE 4 continuously, it is necessary to have the User Registration and Software License Activation. The Registration and Activation are available to be processed when Cubase LE 4 is activated on a computer connected to the Internet. Click “Register now” which is shown when activating, enter all the items. If it is not recognized as Registration, Cubase LE 4 can only be used for a limited period after installation.

3. **“PDF Manuals and Drivers” CD-ROM supplied with R16 Drivers-Windows “Setup.exe”** or Download the latest “ZOOM R16 Audio Driver” from ZOOM homepage (http://zoom.co.jp) and install it on a computer.

   ZOOM R16 Audio Driver software is required to enable use of Cubase LE 4 for audio input and output with a computer. Refer to the read me file included in the download package for instructions on how to install the driver correctly.

   **[How to install the driver]**

   Double-click Setup.exe file to activate the installer.

   **Set language selection**

   Choose language and click [OK].

   **NOTE**

   We recommend you upgrade the system software to the latest version on the R16. An R16 operated on an old system may not be recognized correctly. The latest version can also be downloaded from our homepage.

4. **Start InstallShield Wizard**

   Click [Next] to start installation.

5. **Driver-Plug In selection screen**

   If you use SONER, select Installation Plug In for Control Surface.

6. **Ready to install the program**

   Click [Install] to start installation.

   **NOTE**

   If a warning dialogue “Install software” appears, click [Continue]. If a warning dialogue “Windows security Driver Software Licensee cannot be verified” appears, click [Install this driver software].

7. **Set and connect the R16 to the computer using a USB cable.**

   **How to set and connect the R16**

   1. **Press.**
   2. **Select AUDIO INTERFACE**
   3. **Execute.**
   4. **Select of how to continue settings.**
   5. **Connect USB cable to the R16**
   6. **Connect USB cable to computer**

   **NOTE**

   A message “ZOOM R16 Audio Driver (No Response)” may appear, but it is not a problem. Wait until it responds.

   If a warning dialogue “Windows security Driver Software Licensee cannot be verified” appears, click [Install this driver software].

   **NOTE**

   When the connection is operated on the R16, it is recognized by the computer. If this is the first time to connect the R16, wait until the message “Your devices are ready to use” appears.

8. **Start to “Found New Hardware”**

   Choose [No, not this time] of Windows Update and click [Next].

   **NOTE**

   If a warning dialogue “Install hardware” appears, click [Continue].

9. **“Found New Hardware Wizard completed”**

   Click [Finish] to complete installation.

   When connected operation on the R16 side is finished, it is recognized by the computer.

   Connects the first time. Please wait until the message of “The device was able to be prepared” is displayed.

10. **Bring up the “Sound” window from the Control Panel and make the input device setting for the computer.**

    To bring up the “Sound” window, select “Control Panel” from the Start menu and click “Hardware and Sound”, then click “Sound”.

    **NOTE**

    In the “Sound” window, verify that “R16 Audio Interface” is listed under the Play and Record devices and that the device is checked. (To switch between Play and Record, click the tabs at the top of the window.)

    If the device is not checked, right-click on the icon for the device and click “Set as Default Device” so that a check mark appears.
Windows Vista / XP

This Cubase LE 4 Startup Guide explains how to install Cubase LE 4 on a computer, make connections and other settings for the R16.

1. Insert the supplied “Cubase LE 4” DVD-ROM into the DVD drive of Macintosh. And start installation.

   - The contents of the DVD-ROM will be shown automatically. If they are not shown automatically, double-click “Cubase LE 4” icon displayed on the desktop.
   - When the contents of the DVD-ROM are shown, double-click “Cubase LE 4 for Macintosh” icon to open and install it using “Cubase LE 4.mpkg”.

2. “PDF Manuals and Drivers” CD-ROM supplied with R16 Drivers/Mac “ZOOM R16Driver” or Download the latest “ZOOM R16Driver” from ZOOM homepage (http://zoom.co.jp) and install it on a computer.

   - ZOOM R16Driver software is required to enable use of Cubase LE 4 for audio input and output with a computer.
   - Double-click installer (ZOOM R16Driver.pkg) icon. Start it in accordance to the instruction.

3. Set and connect the R16 to Macintosh using a USB cable.

   - Open the “Applications” folder and then the “Utilities” folder, and double-click “Audio MIDI Setup”.
   - Clicking here...
   - This button is clicked.

4. Open the “Applications” folder and then the “Utilities” folder, and double-click “Audio MIDI Setup”.

   - The Audio MIDI Setup screen appears. Click “Audio Devices” and check that “ZOOM R16 Driver” is selected as default input/output.

5. Start Cubase LE 4. Then access the “Devices” menu, select “Device Setup...” and click “VST Audio System”.

   - To start Cubase LE 4, double-click the Cubase LE 4 icon in the “Applications” folder.
   - After startup, be sure to verify that “ZOOM R16 Driver” is selected in the right section of the Device Setup window.

   - If another device is selected, use the pull-down menu to change the selection to “ZOOM R16 Driver”.

   - When the setting is done, click OK button and close the window.

   - From the “Devices” menu of Cubase LE 4, select “VST Connections” and set the device containing the string “ZOOM R16 Driver 1 ~ 8” as input port and output port.

   - Use the tabs at top center to switch between input and output, and verify that “ZOOM R16 Driver 1 ~ 8” is selected as device pair.

   - If another device is selected, click the device port field and change the selection.

For optimum enjoyment

   While using Cubase LE 4, other applications may slow down drastically or a message such as “Cannot synchronize with USB audio interface” may appear. If this happens frequently, consider taking the following steps to optimize the operation conditions for Cubase LE 4.

1) Shut down other applications besides Cubase LE 4. In particular, check for resident software and other utilities.

2) Reduce plug-ins (effects, instruments) used by Cubase LE 4. When there is a high number of plug-ins, the computer’s processing power may not be able to keep up. Reducing the number of tracks for simultaneous playback can also be helpful.

3) Power the R16 from an AC adapter. When a device designed to use USB power is supplied via the USB port, the current supply may sometimes fluctuate, leading to problems. See if using an AC adapter improves operation.

Please set latency from the device menu when the sound cutting occurs. Refer: Install Guide-step5 about details.

If applications still run very slowly or the computer itself does not function properly, disconnect the R16 from the computer and shut down Cubase LE 4. Then reconnect the USB cable and start Cubase LE 4 again.

Mac OS X

This Cubase LE 4 Startup Guide explains how to install Cubase LE 4 on a computer, make connections and other settings for the R16.

5. Start Cubase LE 4. Then access the “Devices” menu, select “Device Setup...” and click “VST Audio System”.

   - To start Cubase LE 4, double-click the Cubase LE 4 shortcut icon which was created on the desktop.
   - After startup, select “ZOOM R16 ASIO Driver” as the ASIO driver in the right section of the Device Setup window.
   - When the connection is operated on the R16, it is recognized by the computer.

   - NOTE

   - Use a high-quality USB cable and keep the connection as short as possible. If USB bus power is supplied to the R16 via a USB cable which is more than 3 meters in length, the low voltage warning indication may appear.

   - For optimum enjoyment

   While using Cubase LE 4, other applications may slow down drastically or a message such as “Cannot synchronize with USB audio interface” may appear. If this happens frequently, consider taking the following steps to optimize the operation conditions for Cubase LE 4.

1) Shut down other applications besides Cubase LE 4. In particular, check for resident software and other utilities.

2) Reduce plug-ins (effects, instruments) used by Cubase LE 4. When there is a high number of plug-ins, the computer’s processing power may not be able to keep up. Reducing the number of tracks for simultaneous playback can also be helpful.

3) Power the R16 from an AC adapter. When a device designed to use USB power is supplied via the USB port, the current supply may sometimes fluctuate, leading to problems. See if using an AC adapter improves operation.

Please set latency from the device menu when the sound cutting occurs. Refer: Install Guide-step5 about details.

If applications still run very slowly or the computer itself does not function properly, disconnect the R16 from the computer and shut down Cubase LE 4. Then reconnect the USB cable and start Cubase LE 4 again.


   - To start Cubase LE 4, double-click the Cubase LE 4 icon in the “Applications” folder.
   - After startup, be sure to verify that “ZOOM R16 Driver” is selected in the right section of the Device Setup window.

   - If another device is selected, use the pull-down menu to change the selection to “ZOOM R16 Driver”.

   - When the setting is done, click OK button and close the window.

   - From the “Devices” menu of Cubase LE 4, select “VST Connections” and set the device containing the string “ZOOM R16 Driver 1 ~ 8” as input port and output port.

   - Use the tabs at top center to switch between input and output, and verify that “ZOOM R16 Driver 1 ~ 8” is selected as device pair.

   - If another device is selected, click the device port field and change the selection.